A User Guide to the CRAM Tool

1. Aims and purpose of the tool

As we consider making the transition from conventional teaching models to running a module
wholly online, it will be important to consider the extent to which this process is beneficial to
both students and staff. If it improves the learning experience but at the cost of increased
staff workload, it will be unsustainable; if it improves workload but diminishes the quality of
the learning experience, it will be unacceptable.

The critical question for an online course strategy is: can we improve quality without
increasing the per-student workload for academic staff, for higher student numbers? The
Course Resource Appraisal Model is an online modelling tool that enables a course team to
model and test their approach to going wholly online. It elicits the main design ideas and
parameters, and summarise the implications of these in terms of its learning benefits and
teaching costs. Where the bottom line looks unacceptable, the team can experiment with
changing any of the parameters and so work out what course design would work better.

This is a modelling tool, so there are no right answers. It is simply a tool to explore the
possibilities.

2. Introduction

8 O 0 Course Resource Appraisal Model
Build: 168 Date: January 27 2014

create a New Module from scratch, or CO urse Resou rce

Open a Module that already exists (as

illustrated in Figure 1). In this document Appralsal MOdel

we shall assume that the user begins by

The tool starts by asking the user to either

| New Module... | | OpenModule... | | Quit... |

creating a new module from scratch.
Figure 1: The Startup Dialogue Box
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3. New Module Dialogue box

The ‘New Module’ dialogue box 8.0.0 New Module
contains several sections, as Module Name Details
" din Fi 5 Th | Tutor Group Size: 0
illustrated in Figure 2. The upper Credit Hours. y
section contains basic details of the Number of Weeks: 0
module. At a minimum the user is Runs
Run 1 Run 2 Run 3
required to enter the name of the Number of Home Students 0 0 0
mOdUle, the number Of StUdentS per Home Income for Teaching (per Student)* 0 0 0
tutor grou for the module the Number of Overseas Students 0 0 0
& P ! Overseas Income for Teaching (per Student)* 0 0 0
number of credit hours that the Day.rate for lower cost staft* o o 0
module provides, and the number of Day rate for higher cost staff* 0 0 0
Teaching & Learning Activities
Weeks that the mOdUIe runs. Activity Number of Weekly Non-Weekly Total
Weeks Learner Hours | Learner Hours | Learner Hours
In addition, the user is asked to enter
the estimated number of home and
overseas students per run, at least
for the first run. Optionally, the user
Add... Edit
may enter the home and overseas
oK | Cancel

teaching—related income per student '
for the module, and the daily rates Figure 2: 'New Module’ Dialogue Box
for lower cost and higher cost

members of teaching staff. The teaching—related income is roughly half the student fee, as
the remainder pays for administrative costs and overheads, and this is just an analysis of the

teaching—learning activities.

As an example, a postgraduate MA degree typically contains six modules. If the home and
overseas student fees for the degree are approximately £6000 and £13000, respectively, then
the home and overseas student fees for each module are approximately £1000 and £2000,
respectively. The share of income for teaching each module is therefore typically ~50%, i.e.
£500 for a home student and £1000 for an overseas student.

The distinction between lower cost and higher cost members of staff often matches the
distinction between the member of staff responsible for developing, writing and preparing
the course and the member of staff responsible for teaching on the course, advising, marking,
etc. Acommon example is one where a professor acts as the course leader, and a
postgraduate teaching assistant takes the course tutorials. In this example, the professor
would be classified as the higher cost member of staff, and the teaching assistant as the lower
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cost member of staffl. The model only asks for two approximate staffing cost figures, because
these are essentially rough estimates to support the design process, not exact budget figures.

The lower section of the ‘New Module’ dialogue box contains a list of Teaching & Learning
Activities (TLAs) for the module, which is initially empty. To add a new activity, the user
should click the Add... button, prompting the user through a sequence of dialogue boxes (the
TLA Creator Wizard) to provide the description of the activity, as described in section 3 above.
When the user has entered the activities for the module, the OK button of the ‘New Module’
dialogue box closes the dialogue box and opens a new window that describes the module, as
detailed below in section 5.

4. TLA Creator Wizard 800 TLA Creator Wizard

Steps Create Teaching & Learning Activity (1 of ..)

. Create Teaching & -
Learning Activity (2) Browse Existing Activities
Select Predefined

Start from Scratch

The (Teaching—Learning Activity) TLA Creator

1.

2

Activity

3. Learning Details
4. Interaction Details
5. Activity Details

Wizard presents the user with a sequence of
steps to create a teaching—learning activity.
In the first step (shown in Figure 3), the user
is asked to decide whether to use an existing
activity by browsing the ones available, or to
create a new activity from scratch. We shall

first describe the user interface flow if the k) [Nea> fallcecc
user decides to browse existing activities, and Figure 3: TLA Creator Wizard—First Step
later describe the user interface flow when

creating a new activity from scratch.

1 Each institution will determine how to calculate the daily cost of a member of staff. A nominal day is assumed to contain
7.5 hours.
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e 0o TLA Creator Wizard

4.1. Browsing existing TLAs s e

The user is presented with an interface | | mka’  presno s simone
for browsing existing activities according | ” o =i =

to each activity’s student interaction —— N
and student feedback. Two lists of Fomae E:Zf,‘aif.un R
existing activities are presented: the :d

left-hand list includes a pre-defined list |

Summative Assessment

utored discussion online

Social (size: 5), Online, Time-specific, Tutor-present, Tutor feedback

of activities provided by the developers;
the right-hand list includes all those

activities that the user has already <oack | [ Next> Cance
created. For example, in Figure 4, the Figure 4: TLA Creator Wizard—selecting an
user has selected check boxes to browse existing Teaching-Learning Activity

for an online activity for which there is a tutor present, where the tutor or the student’s peers
provide feedback. The window shows all the existing activities with those properties. When
an activity is selected, a description of its characteristics is provided in a text box below the
lists, in addition to the distribution of learning types described for that activity, which is
shown in the pie chart. In Figure 4, the user has selected ‘Tutored discussion online’. Here the
pie chart is showing that for this TLA the dominant learning type is ‘discussion’, along with
learning through ‘inquiry’ (such as asking questions of the tutor) and ‘acquisition’ (such as
listening to the tutor’s explanations). It also indicates that the tutor group size is 5.This value
is used to estimate total support time. If tutors are supporting small groups, then the total
support time will depend on the quantity and size of these small groups.

In the next step, shown in Figure 5, the wizard prompts the user to enter the number of hours
spent on this activity by the learner and by members of the teaching staff.

If the activity takes place weekly, then -~ o

the user should enter the number of T lamay Lo e Aens

weeks for which the activity takes place, |* At o ettt [ of [0 s | Non-west: [ G
along with the number of hours per o DWk Mo e e
week that the learner is expected to s Z Z r =
spend on it. However, if the activity ——— /dw - : hc — &
takes place only once or irregularly (such . O e IS S
as fieldwork, or a summative \) - : : e
assessment), then the user should enter (S 3 O T T i T ey

the total number of hours the learneris | Cance
expected to spend for the whole module Figure 5: TLA Creator Wizard—entering

on that activity under ‘non-weekly details for a Teaching-Learning Activity

hours’.
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The user is asked to enter the number of hours required for the teaching staff to prepare the
activity for each run, and the number of hours required by the teaching staff to support the
activity. For example, in Figure 5 students are expected to spend three hours per week over a
period of 10 weeks engaged in online tutored discussion. The user estimates that it will take
three hours per week in the first run of the module for the teacher to prepare for the three
hours per week of learner time, reduced to two hours per week and one hour per week in

subsequent runs.

The number of hours per week needed to support the activity (for all the five students who
are members of the tutor group) in this case, is six hours, that is, twice the number of hours
that the students are expected to spend (perhaps assuming that the tutor reads and
comments on all discussion threads, whereas students will not). This amount is constant
across all three runs of the module because the amount of per student, or per group support
is assumed to remain stable. The user may also specify the degree to which a lower or higher
cost member of teaching staff engages in preparing or supporting this activity. In the example
provided, the user estimates that a higher cost member of staff is responsible for preparing
the activity (such as developing materials) for all three runs, whereas a lower cost member of
staff is responsible for supporting learners (such as presenting tutorials) for all three runs.

Clicking the Finish button will close the wizard, causing the activity to be added to the list of
activities in the ‘New Module’ dialogue box shown in Figure 2. From there, the activity can be
edited or deleted.

4.2. Creating a new Teaching—Learning Activity

Instead of browsing existing teaching—learning activities, the user may create a new one from
scratch (for example, when the list of existing activities is insufficient). The sequence of
dialogue boxes is similar to that described in section 3.1, with the addition of two extra steps
described below.

8006 TLA Creator Wizard

Steps Learning Details (2 of 4)

1. Create Teaching & Teaching & Learning Activity Name

If the user selects the option ‘Start from o 20 Acity Building up own notes

3. Interaction Details % each learnin g type it elicits Nature of Learning Experience
4. Activity Details

Scratch’ in the first step of the TLA acqusivon: (== | o) [smeforan
Creator Wizard (as shown earlier in Figure e o
3), the next step (shown in Figure 6) inguiry: = [ 30
prompts the user to enter the name of
the activity, the learning types it elicits
and the nature of the learning experience

it provides. The learning types for each

activity are represented in terms of <hack | [ Nex> Cancel
sliders, in which each slider represents Figure 6: TLA Creator Wizard—entering

the percentage of each learning type Learning details for a Teaching—Learning Activity
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elicited by each activity2. (The button labelled Normalise can be used to make the

percentages add up to 100%.) The user should then select the nature of the learning

experience for the activity from the menu that contains the following options: Personalised,

Social and Same for All, with the following definitions.

* A Personalised TLA is one in which each student receives feedback from a program, or

quiz, or works with a tutor. It assumes that the tutor group size is one student.

* For a Same for All activity each student interacts in the same way with a tutor or

the materials. The group size is the cohort size for the run of the module.

* For a Social activity students are working with other students in a group—this requires

the user to enter the maximum size of each group.

The next step prompts the user to enter
the interaction details for the activity,
comprising the Student Interaction and
nature of Student Feedback. The user
may select any number of the four kinds
of Student Interaction (or none), and one
kind of Student Feedback. In Figure 7, we
illustrate a completed example for the

activity named ‘Building up own notes’.

The next (final) step prompts the user to
enter the number of hours spent on this

activity by the learner and by members of

806 TLA Creator Wizard

Steps Interaction Details (3 of 4)

1. Create Teaching &
Learning Activity

2. Learning Details

3. Interaction Details

4. Activity Details

Teaching & Learning Activity Name

Student Interaction Student Feedback
Tutor Present Tutor

Online Peer
Location-Specific Computer-based

Time-Specific (®) None

)
-y -

@same for Al

< Back Next > Cancel

Figure 7: TLA Creator Wizard—Entering Interaction
details for a Teaching—Learning Activity

teaching staff. This is the same information as described earlier in section 3.1 (when browsing

predefined activities). To complete the entry of the details of the new activity, the user should

click on the Finish button. This will add the activity to the list of activities in the ‘New Module’

dialogue box as described in section 2.

The user should click on the OK button when all the detail of the module and activities have

been entered —this will close the ‘New Module’ dialogue box and open a new window that

presents an overview of the module.

2 see the Appendix for definitions of learning types.
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5. Open Existing Module

Instead of creating a new module, the user can open an existing module. The user is

presented with a dialogue box from which to choose a file containing a module description—

the file ends with the extension ‘.mamx’.

6. CRAM Window

The CRAM window provides a
display of the data for a single CRAM
module. The numeric data are
arranged in concertina format on
the left—hand side of the window,
alongside charts and a summary
table in the right—hand side—i.e. the
header of each ‘pane’ can expand
and collapse. The following
paragraphs describe each pane of
the CRAM Window, with reference
to Figure 8, in which all panes have
been expanded.

Module Data

The Module Data pane of the CRAM
window presents the details of the
module as originally entered, as
described in section 2 above. The

Overseas Income for Teaching (per Student)*

8 0 0 Example.mamx
| Module Data Learning Types 2)
Module Name Details
Example Tutor Group Size
Credit Hours Acquisition
Collaboration
Number of Weeks Discussion
g
Runs . Inquiry
Run 2 Run 3 \ Practice
Production
Number of Home Students 10
Home Income for Teaching (per Student)* 500
Number of Overseas Students 10

Learning Experiences

Day rate for lower cost staff* 182 Personalised
Day rate for higher cost staff* 450 Social
Same for All
Student Hours _
Learner Feedback 2
- Number of Weekly Non-Weekly Total
Activity Weeks Learner Hours | Learner Hours | Learner Hours 801
Tutored discussion online 10 0 70
Reading online and offline 12 0 o
Formative practice 12 22 %
Summative Assessment 12 23 £ u Tutor
“
Building up own notes 12 0 2 et
Exploring resources 12 0 301 o
Application of Concept 12 0 2 e
Personal Tuition 12 L5 10
Self-regulated Learning 0 153 .
Feedback to individuals or group
Tutor Hours
— Preparation Support Teacher Time (hours) ®
Y Run 1 Run 2 Run 1 Run 2
Tutored discussion ... 230.0 52.0 840  108.0 7007
Reading online and 0. 250.0 38.0 27.0 10.0 600]
Formative practice 8.0 2.0 15.0 20.0
Summative Assessment 12.0 2.0 225 30.0 P
Building up own notes 10 0 0 A 400]
Exploring resources 10 0 0 ol ® Support Hours
Application of Concept 10 0 0 p ® Preparation Hours
Personal Tuition .0 .0 225 30.0 200
Totals 503.0 94.0 171.0 198.0 100 I
0 -
e Run1 Run 2 Run3
- Preparation Support
G Run 1 Run2 Run 1 Run2 Summary Q)
Tutored discussion ... £13,800  £3,120 £2,038  £2,621
Reading online and o...  £15,000  £2,280 £655 £243 Bunil, Ritn;2, Bung,
Formative practice £480 £120 £364 £485 Student ... 15 20 20
Summative Assessment £720 £120 £546 £728 Support... 1 198 189
|| |puilding up own notes £60 0 0 0 Preps - 503 94 12

Figure 8: Example Module

user may directly edit all the fields in this pane, which in turn will update the contents of the

tables and the charts.

Student Hours

The Student Hours pane presents a list of the teaching—learning activities that comprise the

module in terms of the learner hours that have been assigned to each activity. Each activity is

presented as a row in the table, with an additional row that describes the learner hours

assigned to self-regulated learning3.

The total learner hours for an activity is calculated by adding the number of non—-weekly

learner hours to the product of the number of weeks and the number of learner hours.

3 Calculated by subtracting the sum of the total TLA learner hours from the number of credit hours required for the module.
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The user may edit the details for an activity by double—clicking on a row of the table (except
for the row that describes self-regulated learning), or by selecting a row and then accessing
the menu option Activity>Modify Activity.... Either operation prompts the user with a
dialogue box in which the details of the activity may be modified.

The user may remove an activity from the module by selecting it in the table and then
selecting the menu option Activity>Remove Activity... in which case the user is given the
chance to confirm removal of the activity.

Finally, the user may add an activity via the menu option
Activity>Add Teaching & Learning Activity.... This operation prompts the user with the TLA
Creator Wizard as described in section 3.

Tutor Hours

The Tutor Hours pane presents an alternative view of the activities that comprise a module:
one in which the number of tutor hours is detailed. In addition to the teaching—learning
activities presented in the Student Hours pane, the list in the Tutor Hours pane also includes
module activities. A module-level activity is one that is undertaken by a member of teaching
staff, such as staff induction, staff evaluation, module administration or CPD.

For each activity, the table presents the number of hours that are required to prepare for the
activity and to support it for each of three runs?. The values in the table are calculated in the
same way as described in the Student Hours panel. For example, the value for the number of
hours taken to prepare for the first run of an activity is calculated from the number of non—
weekly hours to prepare for the activity in addition to the product of the number of weeks
duration of the activity and the number of hours to prepare each week for the activity.

The calculation of the number of hours to support a run of a teaching—learning activity takes
into account the activity’s learning experience. For example, a Social activity may have a tutor
group size of 15. If the student cohort for the run is 30, then two tutor groups will be required,
and thus the number of hours to support the activity is multiplied by two.

Likewise, the calculation of the number of hours to support a run of a module activity takes
into account the number of tutor groups for the module as a whole. For example, if the tutor
group size for the module is 20, and the student cohort for a run is 40, then the calculation
assumes that two tutors will undertake the module activity.

4 A Module-level Activity does not require separate preparation/support times.
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The user may edit the details of the teaching-learning and module activities in the same way
as described for the Student Hours pane. Similarly, the user may remove an activity by
selecting it in the table and using the menu option as described above.

The user may add a teaching-learning 8.0.0 Create new Module Activity

Module Activity Name
activity to this table as described for the

Student Hours pane, and add a Module AUpRortHours

Hours per Non-Weekly Higher Lower
ACtiVit via the menu o tion Week Hours Cost Staff Cost Staff
y p Run 1: 0 0 0% 100%
Activity>Add Module Activity.... This S 5 5 por 100K
prompts the user to complete the details Rueias o 0 0% 100%
for the module activity as illustrated in —
—OK— Cancel

Figure 9. The dialogue box is similar to the
one described earlier to describe the details ~ Figure 9: New Module Activity Dialogue Box
of a teaching-learning activity, except in this

case there are no learner hours or teacher preparation time.

Tutor Costs

The Tutor Costs pane presents a similar view to that of the Tutor Hours pane, but with the
focus on the costs of preparing and supporting the module’s activities. For each activity, the
table presents the cost incurred to prepare and support the activity for each of three runs.
The values in the table are calculated in much the same way as described in the Tutor Hours
panes, but includes the percentage allocation to lower and higher cost members of staff,
along with their respective day rates®.

Learning Types Chart
The Learning Types Chart is a pie chart that

summarises the distribution of learning o

types for the module. (An example is shown Collaboration
in Figure 10.) The user may hover the cursor Discussion
above a segment of the pie chart to view & Inquiry

the name of the segment in addition to the e g:‘zii:ccinon

percentage of learning type that the module Double-click for more

elicits. If the user double-clicks on a

segment of the pie chart, a small dialogue

) . Figure 10: Learning Types Chart
box appears, presenting a list of the

teaching-learning activities that contain the learning type corresponding to the selected

segment. From the dialogue box, the user may select a teaching-learning activity to modify,

5 A Module Activity does not require separate preparation/support times.

6 A nominal day is considered to be 7.5 hours.
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which will cause the user to be presented with another dialogue box in which the details of
the activity may be modified.

Learning Experiences Chart

The Learning Experiences Chart summarises
Personalised

the distribution of learning experiences for
@ Social
the module. The user may hover the cursor same for All (72%) same for All
above a segment of the bar chart to view Double-click for more
the name of the segment in addition to the Figure 11: Learning Experiences Chart

percentage of learning experience that the

module provides. An example is shown in Figure 11. If the user double-clicks on a bar of the
stacked bar chart, a small dialogue box appears, presenting a list of the teaching-learning
activities that contain the learning experience corresponding to the selected bar. From the
dialogue box, the user may select a teaching-learning activity to modify, which will cause the
user to be presented with another dialogue box in which the details of the activity may be
modified.

Learner Feedback Chart

The Learner Feedback Chart provides a
80 |

summary of the kinds of feedback provided

70 4
A

to individuals or groups. Each bar 60 -
corresponds to the number of hours of tutor v 50 e
5 eer
- o 40
feedback, peer feedback and computer T B Computer-based
based feedback. Figure 12 indicates that the 20 W Tutor
20 -
example module provides only tutor Al 7
10 Tutor (79.5 hours)
feedback—the user has hovered the cursor 0 S P [
above a bar of the chart to view the number Feedback to individuals oFgrotp

of hours it represents. If the user double-

clicks on a bar of the bar chart, a small Figure 12: Learner Feedback Chart

dialogue box appears, presenting a list of all the teaching-learning activities in the module.
From the dialogue box, the user may select a teaching-learning activity to modify, which will
cause the user to be presented with another dialogue box in which the details of the activity
may be modified.
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Teacher Time Chart 7001

The Teacher Time Chart is a stacked bar 600+

chart that summarises the amount of time 500

spent by teaching staff preparing and 400

supporting a module for all runs. The user 3001 ® Support Hours
may hover the cursor above a bar of the S0 # Preparation Hours
chart to view the name of the bar in 100, % .

addition to the number of hours that it o Preparation Hours, Run 1 (503)

represents. An example is shown in Figure
13.

Runl1 Run 2 Run 3

Figure 13: Teacher Time Chart

Summary Table

The Summary Table (illustrated in Figure 14) Run 1 Run 2 Run 3
presents a description of the module in terms of | |Student... 15 20 20
|Support ... 171 198 189
the total number of students, the hours Prep. Ho... 503 94 12
required to prepare and support the module, Total Ho... 674 292 201
Income £10,000 £15,000 £15,000
the teaching-related income received and the |Cost £34,330 £10,445 £5,306
costs incurred, and also the difference between |Difference -£24,330  £4,555 £9,694]

the income and costs, for each run of the Figure 14: Summary Table

module.

7. Menus | @ CRAMTool File Edit Activity Windows Help |
The CRAM tool provides a menu bar for the Macintosh File Edit Activity Windows Help |
platform and a per-window menu for the Windows platform Figure 15: Menus

(as shown in Figure 15). In both cases, the contents of the

menus are identical. We have already described the menu items available from the Activity
menu to add, remove and modify a teaching-learning activity or a module-level activity. The
other menus are described below.

File

The menu items in the File menu provide the functionality to create a new module (via
New...); to open an existing module (via Open...); to duplicate the module presented in the
frontmost window (via Duplicate); to save the module (via Save As...); or to quit the CRAM
tool (via Quit...). In addition, the File menu offers an option to export a report of the module
in the form of a Microsoft Word document (via the menu item Export Report...)—this option
presents the user with the usual dialogue box specify where to save the document.
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Edit
The Edit menu provides the user with the ability to undo or redo previous changes, as well as
the usual cut, copy and paste operations.

Windows
The Windows menu provides a list of menu items corresponding to the open CRAM Windows,
that is, the collection of modules that are currently being viewed or edited.

Help
The Help menu contains a menu item that can be used to open the User Guide (i.e. this
document).

8. Contact

The CRAM tool is available from http://web.lkldev.ioe.ac.uk/bernard/cram/index.html. The

tool is part of the Learning Designer project, which is developing learning design tools to
support teachers’ collaborative innovation
(http://buildingcommunityknowledge.wordpress.com/). The tool is still under development,

so we would very much appreciate your feedback, comments and suggestions for further
development. Please contact Bernard Horan (b.horan@ioe.ac.uk) or Diana Laurillard
(d.laurillard@ioe.ac.uk).
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10.Appendix: Definitions of learning types

Learning type

Learning through

Teacher’s role

Acquisition

Reading a text, book, paper,
website, electronic text...

Watching a teacher, demo, model
performance, video...

Listening to a teacher, discussion,
radio, podcast, audio book...

Encourage attention and interest with a clear
structure

Make the ideas and information relevant
Provide illustrations

Link the content to their experience

Collaboration

Working in pairs or groups to
produce a shared output,
combining discussion and
practice to reflect on how best to
produce the performance, design,
text, picture, report, video,
diagram...

Define the goal of the collaboration

Ensure they get feedback that helps them
improve what they produce

Guide them on how to work together

Discussion Discussing, debating, with each Guide the focus and process of the discussion
ther or with the teacher .
othe .o. € teacher, Suggest whether it takes the form of a debate
describing what they know, .
. . i or a dialogue
responding to questions, asking
questions, listening, commenting, | Ensure the students challenge and comment
challenging, critiquing, appropriately
negotiating ideas...
Inquiry Investigating and inquiring into Make the resources accessible
bOOK_S' papers, .agdlo—wsual, Provide a focus for the investigation
physical, and digital resources
with a specific goal to, e.g. find Guide the students in the process of the
information, solve a problem, inquiry
answer a question...
Practice Doing something (an exercise, Ensure the experience and practice links to
using a tool, an educational the goal,
me, makin mething) t
ga .e, aKing >o e. 8) (_) Ensure they get feedback from the
achieve a goal, by using their .
) environment, a peer, or the teacher, to help
knowledge and using the .
them reflect and improve
feedback on what they do to
improve their knowledge and
skill...
Production Producing a text, performance, Define what the product should be

design, picture, video, diagram,
report, by reflecting on their
reading, investigations,
discussions, practice or
collaboration

Make sure it draws on previous learning or
experience and relates to the learning
outcome

Set the criteria of what counts as a good
product of their learning

Offer good examples

Provide feedback
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